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Introduction: 

 

Chapter 1: Setting Up a Chart 
Let’s start learning how to use Microsoft Excel with chart and data building. If we have a 

whole bunch of data or information and we want it to be easily read and understood by 

viewers, the best way to do this is to put it in a chart. 

 

Start by putting your data in a table in Excel. In the first row you’ll want to name the 

values you are counting, like how many of something there are. For instance, let’s make a 

table where we have four different types of animals and are recording how many of each 

different animal four people have. 

Follow this format for whatever information or data you are collecting and recording. 

Next we will want to select all of this information, starting in box 1A and dragging our 

select box over the rest of the information, down to 6E.                                                      
 

*See Res. 1 

 

With everything still selected, go to the Insert tab and choose Recommended 

Charts. This will display a new window showing us multiple options Excel thinks is best 

for our data set.  



 

 

 

 

                                                    *See Res. 2 

 

Pick the chart that best displays your information, and remember that the 

Recommended Charts are just suggestions and that you don’t need to pick from these. 

If you want to see more options, click on the icon in the lower right-hand corner of the 

chart box. 

 

Another important thing to note when creating charts is that there are default 

ways to do it faster: 

● By selecting the data you want and pressing Alt + F1 on your keyboard, you 

can display your data in a default 2D bar chart on the same worksheet 

● Instead of pressing Alt + F1, do the same as above but press F11. The chart will 

appear in another worksheet. 

 

 

 



 

 

Chapter 2: Chart Basics 

 

Now that we have a chart made, we can start making changes to the chart such as 

reversing rows and columns and adding or removing titles, tables, legends, and so 

much more! 

  

When you create your chart, you can move it around by dragging it and increase 

or decrease its size by holding down the shift key and dragging one of the chart’s 

corners. The shift key retains the height to width ratio of the chart.  

 

Now, let’s get into the fun stuff! When you select your chart you’ll notice that 

you can change its title. Be sure to give it an appropriate name. On the right side of 

your chart are three square icons: Chart Elements, Chart Styles, and Chart Filters. 

These are all useful ways to customize our chart. 

 

Click on the first box (the one with the plus icon) to expand the Chart 

Elements options. Here you can add Axis Titles, which let viewers know exactly 

what your X and Y axis are. You can also add other elements such as Data labels and 

a Legend. Be careful not to overly complicate your chart with added elements, as the 

simpler your data is, the less supporting elements you need.  

 

 
 



 

Suppose we have a list of monthly revenue from a startup company. If we select 

this company we can put it in a 2D line chart. This throws the data in a line chart 

showing us a single line with each point one unit apart, giving us something like this: 

 

This is not exactly what our chart will look like, but it should be similarly 

formatted. We can go into our Chart Elements tab and add a Legend so that viewers 

know what the line means. In this case we can call it Revenue or any other 

appropriate title. Then we can add a Data Label titled USD to assign units to the 

numbers on the Y-axis. 

 

Next, let’s clarify when this revenue was recorded. Below your data on the 

table, write out each month to go along with a number like so: 

 

Select and right-click the X-axis,  and click Select Data. A Select Data Source 

window will pop up on your screen. Select the Edit button under the Horizontal Axis 

Labels column.  



 

 

This will open another window where you can select and drag across the 

months to add them as labels on this axis. Hit OK to finish selecting the labels, and on 

the Right hand side of the screen will be a Format Axis bar.  

 



 

You can play around with alignment and other features on this and the other 

editors to display your text information just the way you want. By right-clicking 

inside any text area, we can select font and edit our font type, style, size, and any 

other effects.  

 

Chapter 3: Chart Graphic Objects 

Graphic objects in Excel help enhance the viewing experience beyond the basic things 

the chart itself can do. Using arrows, logos, and other objects can be very useful. 

 

If we want to insert an image into our graph, such as a logo, we simply need to 

click on our chart, go to Insert, and under insert click on Pictures. Use the file 

navigation window Excel opens for you to choose an image and click on insert. You 

can then drag and resize this image. 

Under the Format tab, you can find multiple formatting options such as Insert 

Shapes, Shape Styles, and WordArt Styles. With the Insert Shapes tab, we can insert 

arrows and text boxes to point out specific information and improve readability. Shape 

Styles can help make text boxes appear more interesting and aesthetically pleasing. 

WordArt Styles makes it easy to create word art. Note that this is not the same as font 

style and is only meant to be used for a few short text items. 

 

We can edit all the objects we make; for this instance, let’s look at arrows. 

Under Format we can change the weight of the line (how thick it is) as well as the 

colors and look. 

To practice, let’s insert three differently colored squares. Under the Arrange 

tab we can click Bring Forward or Backward. The Selection Pane will allow us to 



 

rearrange all the squares how we like. By adding a Parallelogram into this and with 

some rearranging, we can create 3D objects like below: 

 



 

You can use shape making and rearranging to make even more interesting 

objects that could help support graphs, data, etc. 

 

Chapter 4: Working With Data 
In this section we are going to explore how to manage and filter data with a list. This can 

be useful in creating unique graphs and focusing on only the important information in a 

large collection of data. 

 

Below is an example of a set of information of people checking different electronic 

devices in and out. We will use this data set as an example of manipulating and working 

with information sets. 

 

 

 

 

 

 

 

In order to manipulate all this data, it is important to make sure you select it all (from 

A1 to E8). Under Insert, click on Table.  Also, make sure the My table has headers 

box is checked. 



 

 

Now, under the DATA tab, we can select Filter to make sure a dropdown is placed under 

each header, as seen above. Sometimes this step isn’t needed.  

 

Click on one of the dropdowns and you’ll find multiple options to filter this data. Excel 

can sort different columns by Data, Ascending, Descending, and Type.  

 

 

In this dropdown you’ll also find a Filter… button. Clicking on this will give us a pop-up 

window where we can choose to see all item types, Camera, or just Laptop. Hovering 

over Text Filters will give us options like so: 



 

 
If we type Laptop, our data table will only show items with the Type equal to Laptop. 

The dropdown allows us to manipulate data in similar and very useful ways. The other 

operator types are Does not equal, Begins with, Contains, etc. Depending on the type of 

data that is being displayed, different options to filter it will appear. For example, under 

Checked-In and Checked-Out, the option Date Filters appears instead of Text Filters.  

 

You can use more than one Filter; for example, let’s apply a filter to this table that only 

shows items with the Laptop type. 

 

Then, let’s add a filter than organizes it by a descending date. 

 



 

To clear a filter, you can use the Clear Filter from… button. This clears all filters in that 

column, so if multiple filters are set up, they will all be cleared and no longer affect your 

column. 

 

Another thing to note is that there are numerous options that can change the way data is 

displayed in a table under the Sort & Filter tab. You’ll find similar routes to get to the 

same way of sorting, so don’t be afraid to look around. 

 

It is also important to consider the design of your table and make sure that the sorting is 

used not to just mindlessly sort rather but to make quantitative data easier to read and 

enhance a reader’s experience. For example, if you aim to show trends in similar products 

over time, you would want to sort by Type and then by Date - Descending.  

 

 

 

 

Chapter 5: Math in Excel 

Whether it is a spreadsheet to make a budget, do taxes, or record client information, math 

in Excel is very common and very practical.  

 

Take the data below: 

To take the sum of each person over all four months, the SUM function is required. In 

column F create a column labeled Total. Under Total, in F2, write =SUM(B2:E2).  



 

 

The result: 

This takes the sum of all integer values from block B2 to E2, or all of John’s month by 

month sales. This will give us 60, the added total. When putting in the SUM function, 

dragging over the desired area to be added together also works. 

 

B and E are the Column letters and 2 is the Row number. The colon (“ : ”) tells Excel to 

take values in B2 from E2. The function =SUM(B2, E2) instead would take values from 

only B2 and E2, giving us a sum of 28 not 60.  

 



 

By typing in the equal sign, =, in a block in Excel it declares what is called a Function. A 

function can be an addition function, which takes the sum of something. When you start 

typing after the equals sign there will be a drop down that shows you what options you 

have to pick from. This can be very useful if you aren’t sure which function you need. 

 

There are other statistical functions we can use, such as getting mathematical averages, 

ranges, and more from our data. Let’s take a look back at John and his sales. In column 

G, row 2, let’s create a section for his average monthly sales. We do this by starting out 

all function with the = sign, then typing AVERAGE. 

 

 

 

As you start typing “Average”, you’ll notice more options for different kinds of averages. 

Be sure to select the regular AVERAGE function. This will be the output  

 
 

There are other functions we can call to help us as well. 

MAX - Returns the largest number in a given list: 

 

MIN - Returns the smallest number in a given list: 



 

LARGE - Returns the Nth largest number in a given list. In this case it is the 

second largest. The Nth letter is separated by a comma. 

 

SMALL - Returns the Nth smallest number in a given list: 

 

STDEV - Calculates the Standard Deviation of a set of numbers. This tells us how 

spread out the data is. 

 



 

Another function in Excel is the COUNT function. This counts the number of numeric 

values in an array. Numeric values can be Numbers OR Dates unless specifically stated 

in the count statement.  

This is an example of counting the numeric values in A9 to A12. The date and the 

number two are the only numeric values so it returns two  

 

 

 

 

 

This is example counts data from the array A9 through A12 and also the singular box B9, 

appended on by the separating comma. Because B9’s value is a 0, a numeric value, it 

adds to the count. 

 

We can also call the function COUNTIF 
This function takes in a Range and a Criteria like so: =COUNTIF(Range, Criteria ). In 

this we can actually tell it to count text if you wrap the word/text in quotes. Look at the 

data table below. 



 

 

Cell 

Number 

Equation Result Description 

F1 =COUNTIF(A1:A9,“<>Wednesday”) 6 Counts a cell between A1 and A9 

if it doesn’t equal Wednesday. 

F2 =COUNTIF(B1:B9, ">10/1/2008") 2 Counts a cell between B1 and B9 

if the date is greater than the date 

October 1st, 2008. 

F3 =COUNTIF( C1:C9, 0 ) 2 Counts a cell between C1 and C9 

if it equals the number integer 

 

There are a few important things to note when looking at the equations. To find a value 

greater or less than something, we use similar mathematical operators, the less than (<) 

and greater than (>) signs. Also, the date format can be changed for cells but you must 

make sure that you follow the same format as the cells when counting dates. 

 

The “<>” means “Does not equal”. So in F1 we are looking for everything not equal to 

the string “wednesday”. Excel is not case sensitive, meaning WEDNESDAY is the same 

thing as wednesday.  

 

The PERMUT Function 

Another useful statistical function is the PERMUT function, which returns the number of 

permutations from a specified amount of objects in a list/set of objects. A permutation 

amount is the number of combinations numbers can have with each other in each given 



 

order. This means the number 2 and 3 can be combined into two different ways (2&3, 

3&2). That is a permutation. 

 

The Syntax goes as follows: =PERMUT(number of objects, number of objects in each 

permutation) also seen as =PERMUT(n, k). Below is the equation for permutations 

For example, if we have =PERMUT(3, 2), it will take in each permutation seen below: 

We have the numbers 1, 2, 3 and want them in sets of two. 

 

Permutation 1 Permutation 2 Permutation 3 Permutation 4 Permutation 5 Permutation 6 

1,2 2,1 1,3 3,1 2,3 3,2 

 

 

Our result from the above function would then be 6, because there are 6 permutations of 

numbers 1 through 3 in unique combinations of 2.  

 

Chapter 6: Using Macros 
A Macro in Excel automates certain tasks. It records keystrokes to later be used whenever 

a user needs. 

 

The Macro Recorder records keystrokes and can be located in the Developer tab, under 

Code. Click Record Macro and a Box will appear. Title the Macro to what task it will 

be automating. Add a shortcut to it as well, but be careful not to override any used 

regularly. A description can be added as well. 



 

You can press OK and then all key clicks and strokes are recorded. For instance, if a user 

wanted to automate changing the headers to a table, they would record once a table was 

set up and then change the table headers to the desired look.  

 

Once you finish your moments, go back to the Developer tab and press stop recording. 

Now, everytime you use the command you set up, it will format the exact rows and 

columns you did the same way. Careful, though, as if you formatted a table header, in 

order to have another table header formatted the same way, it must be in the same cell 

array. 

 

If we want our macro to work in any cell, not just the one we were working in when it 

was recorded, we can Use Relative References. This means if I build a 3 by 3 red square 



 

with a middle at F8, then when I run the command to make the square, it will run not on 

F8 but on whatever square I have selected.  

 

To edit a Macro, you must use Visual Basic Application, a programming language. For 

now you can manage your Macros in the development tab. 

 

Chapter 7: Customizing The Work Area 
In Excel, the work area can be customized and changed to fit your needs. The top bar 

containing commands for the Home, View, etc. can be changed along with the data table 

itself. 

 

Under the VIEW tab, there are multiple layout options. By default the Workbook View is 

on Normal. You can also change the layout to your own Custom View, make it Full 

Screen, or make it more presentable to others with the Page Break Preview. 

 

The Custom View takes from the current work area. To create one, you simply need to 

create rows and columns the way you like them with custom labels, values, etc., then add 



 

a new view under Custom View. Two checkboxes will appear  where you can also name 

the view. 

 

After making sure these are checked, press OK and the view will be stored for later use. 

 

Under PAGE LAYOUT, there are themes to customize your work area. Here you can 

change Colors, Fonts, and Effects to make your work area unique.  

 

Under Page Setup, further customization can be done to your workspace to enhance it. 

The Margins control how close text and information can get to the edge of a piece of 

paper. Orientation controls whether the information is displayed vertically or 

horizontally. Size and Print area control how information will show when printed on 

paper. Breaks and Backgrounds add further customization such as ensuring data gets cut 

off onto another sheet of paper at a specified point. 

The Width and Height values in the Scale to Fit tab is usually set to Automatic, but you 

can manipulate the scale  at which a table of data will be displayed on a paper 



 

 

 

 

Sheet Options allows for customization of the sheet layout, with options to put in a 

Heading and Gridlines in both the editing view and on the printed paper copy. 

Arrange has been shown previously to be used for layout options and customization. 

Adding panes and rearranging objects allows for a wide range of work area 

customization. 

 

To customize the Quick Access Toolbar or the Ribbon, right click anywhere at the top 

of the tool bar area. 



 

 

 

The Quick Access Toolbar includes the Save Icon and the Undo and Redo button by 

default. Click on Customize Toolbar to change what it does and doesn’t have. 

 

The Excel Options Window has tabs to edit the Ribbon and Toolbar. To add a feature, 

browse through the command list and click “Add > >”. To remove a feature, click on the 

right-hand panel with the current features on it and click the Remove button. 



 

 

The same process applies to the ribbon, where you have options to make new tabs with 

different features on them. There are also options to export and import data for a custom 

ribbon. 

 

These are the basics of creating a customized workspace, toolbar, and ribbon area. 



 

 

 

 

 

 

 

 

 

 

 

 

Chapter 8: Pivot Tables 
Pivot tables are tables that sort information. Ideally, they calculate and summarize large 

tables of information to get the exact data needed. 

 

These can be created by going to the INSERT tab and creating a Pivot Table manually or 

with the Recommended Pivot Table button. Start with a set of data: 



 

After pressing the Pivot Table it automatically creates a new table in a new tab. 

The new Pivot Table is then created and can be adjusted in the tab on the right. 

 

To manually create a pivot table, click the PivotTable button on the far left. A dialogue 

box will appear. Select New Worksheet, for Existing Worksheet option a worksheet 



 

and specific cell will need to be called to place the table. To analyze multiple tables click 

Add this data to the Data Model.  

Chapter 9: Use Advanced Functions 
Beyond simple mathematical and statistical functions, there are also some advanced 

functions that can help with performing specific tasks. 

 

The function we will cover first is VLOOKUP.  
 

VLOOKUP is an Excel function that is used to lookup and retrieve data from a specific 

column in a table.  

The syntax goes as followed: =VLOOKUP (value, table, col_index, [range_lookup]) 

 

value: The value to look for in the first column of the table 

table: The table from which to retrieve the information 

col_index: The column in the table to retrieve the information from 

[range_lookup]:  This is optional. If a value is not entered, the default will be TRUE. 

TRUE will result in an approximate match and FALSE will result in an exact match. 

 



 

 

 

 

 

 

 

 

In this example, we are getting the First Name, Last Name, and Email of the person 

with ID 602. The value is H2, which is the cell containing the ID (602) we are matching 

to the table. The table is B2:E6 as that block is where the table we are taking information 

from is located. The col_index is 2 as the First Name is in the second column of the table. 

Finally, the [range_lookup] is set to FALSE because we want an exact match rather than 

an approximate match. 

 

The function first looks for “602” in the “ID Number” column. Once “602” is found, the 

function moves over to the column indicated by the col_index. In this case, it is 2. The 

function moves over to column 2, which is the “First” column. Now, it returns that value, 

which is “Julie”. 

 

The rest of the equations go as followed: 

ID 602 

First =VLOOKUP(H2, B2:E6, 2, FALSE) 

Last =VLOOKUP(H2, B2:E6, 3, FALSE) 

Email =VLOOKUP(H2, B2:E6, 4, FALSE) 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now, let’s move onto using names. 

 

Have you ever felt that it is inconvenient putting in table ranges such as “a1:e64” every 

single time you do something with it? This is where names come in handy. 

 

Names are shorthands that makes it easier to understand the purpose of cell references, 

constants, formulas, or tables. 

 

These are some examples of how names may be used. 

 

Example Type Example with no name Example with name 

Cell Reference =SUM(D4:D20) =SUM(Total_Cost) 

Constant =PRODUCT(D10, 

1.083) 

=SUM(Price, Tax) 



 

Formula =VLOOKUP(H2, B2:E6, 

2, FALSE) 

=First_Name 

Table =A1:D23 = 

 

All names in Excel have a scope. A scope is the location where the name will be 

recognized without qualification. The scope can be set to a specific worksheet or the 

entire workbook.  

 

For example, if a name called Price is created in a worksheet named Sheet1 and the 

scope is set to the worksheet, the name will not be recognized in Sheet2.  

 

However, the name made in Sheet1 can be used in Sheet2 if it is qualified. To do this, 

the name must be preceded by the worksheet title it was made in. 

 

Example: Sheet1!Price 

 

Additionally, duplicate names cannot be created within the same scope.  

 

There are several syntax rules that names must follow. The following is a list of those 

rules. 

1. The first character of a name must be a letter, an underscore ( _ ) or a 

backslash ( / ). The remaining characters can be letters, numbers, periods, 

and underscores. 

2. Cell references cannot be used in names. For example, A2 cannot be a name. 

3. Spaces are not allowed in names. 

4. Names must be within 255 characters long. 

5. Names are not case sensitive. Therefore, price and PRICE are not distinct 

names and both cannot be used in the same scope. 

 

There are multiple methods to define a name. The first way is by using the Name box to 

define a cell or cell range on a worksheet. 



 

1. Select the cell or cell range that you want to name. 

2. Click the Name box at the left end of the formula bar. 

 

3. Type the name you want to use to refer to your selection. 

4. Press ENTER. 

 

 

 

 

 

 

Another method to define a name is by using Create By Selection: 

1. Select the range you want to name, including the labels for the columns and 

rows. 

2. In the Formulas tab, in the Defined Names group, click Create from 

Selection. 

 

3. In the dialog box, designate the location that contains the labels for the columns 

and rows by selecting the checkboxes. 

4. By defining a name with this method, the labels for the columns and rows are 

not contained in the name. Only the cells that contain the values are contained. 

 

The final method to define a name is by using the New Name dialog box. 

1. On the Formulas tab, in the Defined Names group, click Define Name. 

 



 

2. In the Name box, type the name you want to use. 

3. The scope can be specified. You can either select the workbook or a specific 

sheet. 

4. While it is optional, a comment can be included as a description. 

 

 

5. In the Refers to box, do one of the following: 

a. Enter a cell reference 

i. Example: =Sheet1!$A$3 

b. Enter a constant 

i. Example : =5.193 

c. Enter a formula 

i. Example : =VLOOKUP(Sheet1!H2, Sheet1!B2:E6, 2, 

FALSE) 

6. Finally, click OK. 

 

 

The last function we will cover is IF. 
 

The IF function is highly versatile and it allows you to make a logical comparison 

between a value and an expected value.  

 

The IF function says the following: 

 

IF(something is true, then do something, otherwise do something else) 

 

The actual syntax goes as following: 

=IF(logical_test, [value_if_true], [value_if_false]) 

 

logical_test: What we are testing the IF with. Example: A2 = 2 

[value_if_true]: The result when the condition is true. Example: “Yes” 



 

[value_if_false]: The result when the condition is false. Example: “No” 

 

 

Above is a simple example of how the IF function can be used. The photo on the left is 

the situation where the condition is satisfied (A1 = 12) and the photo on the right is the 

situation is where the condition is not satisfied (A1 != 12). 

 

When we use the IF function, we are able to make it perform much more complicated 

tasks. 

 

Here is an example of a more complex use. 

 

 
 

What we are trying to solve in this situation is whether or not two people have each other 

down as the first choice.  

 

For example: If Harold’s first choice (George Monet) has Harold down as his first choice, 

the formula returns “Yes”. This is true in this situation. However, if we look at Josh, he 

has Harold down for his first choice. However, Harold does not have Josh down for his 

first choice. Therefore, the formula returns “No”. 



 

 

Let’s break the formula down to make it easier to understand. 

The full formula is =IF(B3 = VLOOKUP(C3, B3:C7, 2, FALSE), "Yes", "No"). 

 

Let’s just look at VLOOKUP(C3, B3:C7, 2, FALSE) for now. 

What this function is doing is looking at C3 (George Monet) and looking for that value in 

the B column, which is the column containing the names. When that is found, the 

function goes to the second column that includes the first choice and returns that value. 

This value is “Harold Smith”. 

 

If we just look at B3 = VLOOKUP(C3, B3:C7, 2, FALSE), this logic statement is 

checking if B3 (Harold Smith) is the same as George’s first pick. This evaluates as true 

because George’s first choice is “Harold Smith”. 

 

Finally, if we go back to =IF(B3 = VLOOKUP(C3, B3:C7, 2, FALSE), "Yes", "No"), 

This is taking the logic statement from above and seeing if it is true. If it is true, the cell 

returns “Yes”. If it is false, the cell returns “No”. 

 

 

 

 

 

 

 

 

 



 

 

 

Chapter 10: Visual Basic for Applications  
Visual Basic for Application is the main programming language for Microsoft Excel. 

This can be used to code Macros and message boxes. Currently discontinued, it still has a 

wide use in businesses today. 

 

To get started, the Developer tab must be visible. If this isn’t already on the ribbon it is 

easy to add by going to File and then options.  

Under Customize Ribbon, click on the Developer checkbox to make sure it has a 

checkmark next to it. This will allow the tab to appear.  

Now under the Developer tab, under the Code box, click on the Visual Basic icon 



 

 

This will bring up a new window called Microsoft Visual Basic for Application.  

To code in VBA, it is best to begin working with a reference. When you create a Macro, 

Excel actual creates code for it. If you haven’t already, go back into the Macro chapter 

and see if you can make a macro that creates a square of colored cells.  

To edit this click on the plus sign on the Modules Folder. Then, find the macro you wish 

to edit and double click it. 



 

When we open this we will see code, specifically, the code that makes up the macro made 

to make a colored rectangle. Before we learn to code, I want to give you an idea of how 

everything works. Look at the difference between hard coded cells and not: 

Hard Coded cells      Not hardcoded 

Instead of telling excel what the cell should look like, the off set tells what the cell to the 

left of the one the user was in should look like.  
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1. https://support.office.com/en-us/article/create-a-chart-with-recommended-

charts-cd131b77-79c7-4537-a438-8db20cea84c0 
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